# TABLE OF CONTENTS

## CHAPTER 1 - INTRODUCTION TO FOXFIRE! REPORT WRITER

1.0 INTRODUCTION .................................. 1 - 1  
1.1 REQUIREMENTS AND INSTALLATION .................. 1 - 1  
  1.1.1 Special Requirements ......................... 1 - 1  
  1.1.2 Installation Overview ........................ 1 - 1  
  1.1.3 Installing Foxfire! to the Network ......... 1 - 2  
  1.1.4 Installing Foxfire! to Workstations .......... 1 - 3  
1.2 FOR FURTHER HELP .............................. 1 - 4  
1.3 FOXFIRE! REPORT WRITER TUTORIAL ............. 1 - 7

## CHAPTER 2 - THE REQUEST MANAGER

2.0 REQUEST MANAGER OVERVIEW .................... 2 - 1  
2.1 REQUEST MENU .................................. 2 - 2  
2.2 REQUEST TOOLBAR .............................. 2 - 4  
2.3 REQUEST LIST ................................... 2 - 5  
2.4 REQUEST TREE ................................. 2 - 6

## CHAPTER 3 - CREATING A NEW REQUEST

3.0 CHOOSING A PREFERENCE SET ..................... 3 - 1  
3.1 ADDING A NEW REQUEST .......................... 3 - 2  
  3.1.1 Adding Data Items ......................... 3 - 5  
  3.1.2 Foxfire! Data Dictionary .................... 3 - 6  
    3.1.2.1 Accessing the Data Dictionary ........ 3 - 7  
    3.1.2.2 Viewing Data Item Definitions ....... 3 - 7  
3.2 FILTERING DATA ITEMS .......................... 3 - 8  
  3.2.1 Filter Command Buttons .................... 3 - 11  
3.3 SORTING AND GROUPING RECORDS ................. 3 - 13  
  3.3.1 Choosing Data Items for Sorting .......... 3 - 13  
  3.3.2 Changing Ascending or Descending Order ... 3 - 14  
3.4 CREATING GROUP BREAKS ......................... 3 - 14  
  3.4.1 Choosing Group Break Options ............. 3 - 15  
  3.4.2 Adding Calculations ...................... 3 - 16  
  3.4.3 Formatting a Group Break ................. 3 - 17  
3.5 OUTPUT SELECTOR FORM ....................... 3 - 18  
  3.5.1 Selecting the Output ...................... 3 - 18
CHAPTER 1

INTRODUCTION TO
FOXFIRE! REPORT WRITER

1.0 INTRODUCTION

The Foxfire! Report Writer lets users create requests for reports, cross-tabs, graphs, spreadsheets, and labels using information from their Debt$Net™ files. Foxfire! provides users with maximum flexibility to easily customize requests. Users have complete control over request content, order, type, and style. Requests are quickly created, edited, and printed and requests are kept on file allowing you to generate them over and over, as needed. Foxfire! Report Writer satisfies unique client reporting requirements, and may be used to query Debt$Net™ data or export data to spreadsheets, databases, or other file formats.

This manual provides instructions for installing the Foxfire! Report Writer into your Debt$Net™ system, as well as step-by-step directions to help you create report requests; filter, sort and group requested data; and format report output.

1.1 REQUIREMENTS AND INSTALLATION

1.1.1 Special Requirements

The Foxfire! Report Writer Extended Service Option is designed to work on PCs currently running Debt$Net™ version 6.9 or later. This ESO requires no special installation or setup.

1.1.2 Installation Overview

The Foxfire! Report Writer ESO is easily installed on your computer using the installation program on the supplied CD. You must first exit Debt$Net™ before installing Foxfire!, then follow the steps below.

There are two steps to installing the Foxfire! Report Writer ESO. First, install Foxfire! on your network server, then install the Foxfire!
workstation program onto all workstations. The workstation install installs workstation specific libraries and fonts so that other users may access Foxfire! from their Debt$Net™ systems.


1.1.3 Installing Foxfire! to the Network

1. Insert the Foxfire! Report Writer CD into the CD-ROM drive of your network server. If the Foxfire! Report Writer Setup Screen does not display, click the Windows “Start” button on the bottom of your screen and select “Run...” from the Start Menu. Type ‘D:\Setup.exe’, where ‘D’ is your CD-ROM drive (Figure 1-1). Click the “OK” button.

![Run Dialog Box](image)

Figure 1-1. Start Menu “Run” Option.

2. The Foxfire! Welcome Screen appears. Read the information of the screen and click “Next >” to begin the setup process. You may hit “Cancel” at any time to stop the setup process.

3. When the User Information Screen appears, type your name and your agency name in the corresponding fields, and click the “Next >” button.

4. Next, select your destination location on the Choose Destination Location Screen. Locate the Debt$Net™ directory on your computer by clicking the “Browse...” button. Choose the location of your copy of Debt$Net™ and click “OK”. Click the “Next >” button to proceed.
5. The Start Copying Files Screen appears telling you that Foxfire! files are about to be copied into your system. Review the setup type, target folder and user information listed. If you are satisfied with these settings, click the “Next >” button to copy the files. To change the settings, click the “< Back” button to make any adjustments.

6. The files begin to copy to your system. As the files install the screen displays messages stating that the installed files are being decompressed and registered.

7. When the installation completes, the Setup Complete Screen appears telling you that you correctly installed Foxfire! Click the “Finish” button to complete the process.

1.1.4 Installing Foxfire! to Workstations

1. Insert the Foxfire! Report Writer CD into the CD-ROM drive of each workstation. Click the Windows “Start” button on the bottom of your screen and select “Run...” from the Start Menu. When the Run Window displays, click the “Browse...” button.

2. When the Browse Screen displays, select your CD-ROM drive from the “Look in” drop down list. The Foxfire! files list, with the workstation folder (Workst~1) listed first (Figure 1-2).

![Figure 1-2. Browse Screen with Workst~1 Folder.](image-url)
3. Select the folder named “Workst~1” from the list of selections and click the “Open” button. The workstation file opens and another list of options appears. Choose “Setup” from this list and click the “Open” button again.

4. The Foxfire! Welcome Screen appears. Read the information of the screen and click “Next >” to begin the workstation setup process. You may hit “Cancel” at any time to stop the setup process.

5. When the User Information Screen appears, type your name and your agency name in the corresponding fields, and click the “Next >” button.

6. Next, select your destination location on the Choose Destination Location Screen. Select the location of Foxfire! on your server by clicking the “Browse...” button. Choose the Foxfire! location and click “OK.” Click the “Next >” button to proceed.

7. The Start Copying Files Screen appears telling you that Foxfire! files are about to be copied into your system. Review the setup type, target folder and user information listed. If you are satisfied with these settings, click the “Next >” button to copy the files. To change the settings, click the “< Back” button to make any adjustments.

8. The files begin to copy to your system. As the files install the screen displays messages stating that the installed files are being decompressed and registered.

9. When the installation completes, the Setup Complete Screen appears telling you that you correctly installed Foxfire! Click the “Finish” button to complete the process.

1.2 FOR FURTHER HELP

There are several ways to access help for Foxfire! Throughout the program, you will see help messages displayed in a single-line of text at the bottom of the screen. These messages provide information about the current process or about a highlighted button.
Help is also available at any time by highlighting a feature and pressing <F1> on your keyboard. A box appears explaining the purpose of the feature, as well as how to use it (Figure 1-3).

![Figure 1-3. Request Editor Help Box.](image)

Many Foxfire! screens contain a “Help...” button on the bottom left corner. When you select this button, the Foxfire! Explainer Window displays (Figure 1-4), explaining how to perform the necessary process. Exit this window by selecting the “Close” button at the bottom of the screen.
Additionally, the Foxfire! Report Writer contains a menu selection titled “About Foxfire!” that explains the purpose of Foxfire!, as well as contact information. To access this menu option from the Request Manager Screen, select “Tools” from the Main Menu and scroll down to “About Foxfire!...” The About Foxfire! Screen displays (Figure 1-5).
From the About Foxfire! Screen, you may view information regarding the ability to customize, licensing, Micromega, acknowledgments, and ordering information. Select the “About Foxfire” drop down list located on the bottom left corner of the screen to access this information.

To see a snapshot of the main features of Foxfire! Report Writer, click on the “Map of Foxfire!” button located on the bottom of the screen. The Foxfire! Navigation Map appears (Figure 1-6).

![Figure 1-6. Foxfire! Navigation Map.](image)

### 1.3 FOXFIRE! REPORT WRITER TUTORIAL

The Foxfire! Detail Request Wizard is a tutorial that quickly guides you through the five steps of creating a request. To access the tutorial, click the “New” button on the top of Foxfire’s Request Manager Screen. The New Request - Type and Style Form appears. Click on the button labeled “Use Wizard” and The Detail Request Wizard Screen appears (Figure 1-7).
INTRODUCTION

Follow the on-screen instructions to complete each step of the request process. Be sure to use the “Help...” button to assist you as needed. When you reach the end of the tutorial, you are given the option of previewing your request on the screen or returning to the Main Menu. The tutorial provides a great way to explore Foxfire! before creating new requests on your own.

If you need additional help installing or running the Foxfire! Report Writer, or if you have a question not answered in this manual, please contact:

The Computer Manager Inc.
P. O. Box 1961
Poulsbo, Washington 98370
Telephone (800) 552-8397
Technical Support (800) 893-6335
CHAPTER 2

THE REQUEST MANAGER

2.0 REQUEST MANAGER OVERVIEW

Foxfire! centers around the Request Manager, a master list of all requests that also provides options for creating new reports; editing, running, or deleting existing reports; or previewing Debt$Net™'s default reports. Existing requests list in alphabetical order, and a button bar across the top of the screen gives you complete control over all processes.

In Foxfire! a request is a “complete task for job” containing information defining what data to include in the results (including which to filter and sort) and the report type and output destination. The defining information is called the query; the report type information is called the output.

To open the Foxfire! select the “Foxfire Report Writer” option under the ESOs Menu (Figure 2-1). The Foxfire! Request Manager Screen displays (Figure 2-2).

![Figure 2-1. Foxfire Report Generator Menu Option.](image-url)
The Request Manager Screen consists of four main areas: the Request Menu (the menu bar containing options for “File,” “View,” and “Tools”), the Request Toolbar (the menu bar containing options for “Run,” “Preview,” “New,” etc.), the Request List (the list of requests that displays “Request,” “Description,” “Output,” etc.), and the Request Tree where you may organize requests into folders. The Request Status Bar (at the bottom of the screen) displays the number of requests in the current folder, the user logged in, and the active preference (the way Foxfire! displays information).

2.1 REQUEST MENU

At the top of the Request Manager Screen is the Request Menu (Figure 2-3). From this menu, you may perform all request operations. You may click to select menu options, or you may use keyboard shortcuts (the <ALT> key plus the underlined letter. For example, to access the “File” menu, simultaneously press <ALT> and <F>. The Request Menu provides three menu options on the Request Menu: File, View, and Tools.
From the File menu selection, you may run, preview, create, edit, delete, import, or export requests, or exit the program. You may also create, rename or delete request folders.

From the View menu selection, you may configure the appearance of the Request Manager Screen. Select an option to display or hide the Request Toolbar, Status Bar, Description Bar, or Request Tree. Currently displayed items are flagged by a checkmark. Choose to customize the toolbar button display or change the way the request icons display by selecting large icons, small icons, list icons, or display icon detail.

The Tools menu allows you to change the active preference set, edit data items included in a request, create batches of Foxfire! requests, or move requests between folders. On this menu, you may also view the Foxfire! SQL, count the number of records in a set, view online Foxfire! documentation, add comments to a request, or view system administration information.
2.2 REQUEST TOOLBAR

The Request Toolbar contains options allowing you to perform most of your processes on the Request Manager Screen. The Toolbar consists of nine buttons located at the top of the screen. Table 2-1 explains each button on the Request Toolbar.

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Run" /></td>
<td>The “Run” button tells Foxfire! to produce the output you defined in your request. The request may be sent to the printer, to the screen, or to a file for viewing.</td>
</tr>
<tr>
<td><img src="image" alt="Preview" /></td>
<td>The “Preview” button lets you review the request output on the screen, regardless of the output choice you have specified.</td>
</tr>
<tr>
<td><img src="image" alt="New" /></td>
<td>The “New” button opens the New Request-Type and Style Form. From this screen, you may begin the design process for a new request.</td>
</tr>
<tr>
<td><img src="image" alt="Edit" /></td>
<td>The “Edit” button contains a drop-down list of editing options allowing you to edit different aspects of your request.</td>
</tr>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>The “Delete” button lets you delete a highlighted request. A dialog box appears verifying the deletion:</td>
</tr>
</tbody>
</table>

Copyright 2006 The Computer Manager, Inc.
TABLE 2-1. REQUEST TOOLBAR BUTTONS

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>The “Exit” button immediately exits you out of Foxfire! and returns you to the DebtSNet™ Main Menu.</td>
</tr>
<tr>
<td><img src="image" alt="Dictionary" /></td>
<td>The “Dictionary” button lets you access Foxfire!’s Data Dictionary.</td>
</tr>
<tr>
<td><img src="image" alt="Req Tree" /></td>
<td>The “Req Tree” button lets you hide or show the Request Tree, where you may organize your requests into separate folders.</td>
</tr>
<tr>
<td><img src="image" alt="Views" /></td>
<td>The “Views” button contains a drop down list of display options allowing you to alter the Request List display. The flagged option reflects the current display.</td>
</tr>
</tbody>
</table>

2.3 REQUEST LIST

The Request List is the list of all requests for the active preference set. In the “Details” view of the Request Manager (set under the “View” menu) each line of the Request List contains one request, complete with the following information: short name, description, type of output, user who created it, and the creation date. When you right-click on a selected request item, a pop-up menu displays containing available functions you may perform (Figure 2-4). If you double-click an option, the Request Preview Screen displays and Foxfire! provides options to print and edit the request.
2.4 REQUEST TREE

If you wish to organize your requests into individual folders, you may use the Request Tree. If the Request Tree area is hidden, you may display it by selecting the "Req Tree" button. When the Request Root appears you may right-click on a folder of in a blank area of the Request Tree area to view the Request Tree Options Menu (Figure 2-5).

From the Request Tree Options Menu, you may add a new request to a folder by selecting “New Request...” You may add a new folder for your requests by selecting the “New Folder...” option. When the New Folder Screen appears (Figure 2-6), type a name for the folder in the “Name” field. To create the folder as a subfolder of an existing folder, highlight
the existing folder from the “Create as subfolder of:” list. Click “OK” to create the folder or “Cancel” to exit.

![New Folder Screen](image)

**Figure 2-6. New Folder Screen.**

You may rename an existing folder by highlighting it and selecting “Rename Folder...” from the options menu. Enter a new name where prompted and click the “OK” button.

To delete a folder, highlight the folder you wish to delete and select “Delete Folder” from the options menu. A message box appears to confirm that you would like to delete the folder AND all the requests contained in it (Figure 2-7). Click “OK” to erase the folder and requests or “Cancel” to exit the box without deleting the folder.

![Delete Folder Message Box](image)

**Figure 2-7. Delete Folder Message Box.**
CHAPTER 3

CREATING A NEW REQUEST

3.0 CHOOSING A PREFERENCE SET

Before creating a new request, you need to choose a Preference Set. The Preference Set controls which Debt$Net™ database Foxfire! uses for reporting. When you highlight a preference on the Preference Set Picker, it becomes active. Select the Preference Set that described the databases containing the data you wish to use.

To select a Preference Set, choose “Preference Sets...” from the “Tools” Menu (Figure 3-1).

Figure 3-1. Preference Sets Menu Option.

The Preference Set Picker appears (Figure 3-2). To choose a Preference Set, highlight the set in the list and select “OK.” You return to the Request Manager Screen and the Request List updates with a list of requests created from databases included in the new Preference Set. To select a Preference Set to default at startup, highlight it and select “Use at Startup.” This tells Foxfire! to open with this Preference every time you run the program.
3.1 ADDING A NEW REQUEST

To create a new request, click the “New” button at the top of the Request Manager Screen or select “New...” under the “File” Menu. The New Request - Type and Style Screen appears (Figure 3-3).
If you feel comfortable using Foxfire! you may choose to use the Request Editor to design a new request. Otherwise, you may wish to use the Detail Request Wizard (Section 1.3). The Detail Request Wizard walks you through each step of the design process. To access the wizard, click on the “Use Wizard” button to the right of the screen and follow the directions given. If you choose to use the Request Editor, make your selections on the New Request - Type and Style Screen, as discussed in this chapter.

To manually add a new request, begin by selecting the type of request you would like to create. The Request Type controls the processing and analysis of the request. There are four different Request Types available: Detail, Summary, Cross-Tab, or Labels. Make your selection by clicking the Request Type name. A sample display of the Request Type appears at the top of the screen after you select an option. Table 3-1 explains each Request Type.

<table>
<thead>
<tr>
<th>TYPE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail</td>
<td>Creates a tabular or columnar report, a detailed spreadsheet or a browse list. Each record processes individually and displays on one or more lines.</td>
</tr>
<tr>
<td>Summary</td>
<td>Creates a report that generates calculations on groups of records. Input data must be sorted on the data items you wish to group by and the results display one row per group.</td>
</tr>
<tr>
<td>Cross-Tab</td>
<td>Creates a report that calculates the relationship between two variables. The report displays a matrix showing a relationship between two variables for all records matching filter criteria.</td>
</tr>
<tr>
<td>Label</td>
<td>Creates one label for each record (similar to detail).</td>
</tr>
</tbody>
</table>

After you select the Request Type, you need to choose the layout style for your request. Under “Layout Style,” select a style options from the drop down menu (Figure 3-4). A sample display of each style appears when you select a specific layout style. The style you choose affects the font and placement of information on your report. Table 3-2 explains each layout style option.
Table 3-2. Request Layout Styles.

<table>
<thead>
<tr>
<th>STYLE</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Presentation</td>
<td>Report uses proportional sans serif fonts, such as Helvetica.</td>
</tr>
<tr>
<td>Executive</td>
<td>Report uses proportional serif fonts, such as Times.</td>
</tr>
<tr>
<td>Ledger</td>
<td>Report uses a small proportional font in order to place the maximum amount of text on a page.</td>
</tr>
<tr>
<td>Character</td>
<td>Reports using these styles display in a fixed-space font. These options are not recommended, due to special setup needed.</td>
</tr>
<tr>
<td>New Character</td>
<td></td>
</tr>
<tr>
<td>Character - Web Page</td>
<td></td>
</tr>
<tr>
<td>Web Publisher</td>
<td></td>
</tr>
</tbody>
</table>

After you make your selections, select the “OK” button. The Request Editor Form appears (Figure 3-5).
Figure 3-5. Request Editor Form.

The Request Editor Form allows you to create a new request or edit an existing request. This form provides a “birds-eye view” of the request, and lets you set up specific characteristics.

First, enter the name of the request in the “Name” field located at the top of the screen. If you are editing an existing request, enter that name, otherwise create a new name. The request name should be eight characters, with the exception of the Cross-Tab, which should be seven letters. Enter a description of the request in the “Request Type Description” field. The description appears as the title on the first page of your report, so it should be specific, but brief.

3.1.1 Adding Data Items

Entering a name in the “Name” field enables the “Data Items...” button. This button opens the Data Items Selector Form (Figure 3-6). This form allows you to select data you would like to include in your request.
Figure 3-6. Data Items Selector Form.

The left side of the screen contains a list of all data items available for inclusion on the request. To select a data item, double-click the item and it moves to the “Selected” List on the right side of the screen. To remove an item from the Selected List, double-click it and it returns to the “Available” list. You may change the order of the selected items by highlighting an item and dragging it to the desired position. You should organize the data items according to how you wish them to display on your report.

After you finish selecting data items to include in your request, select “OK” to return to the Request Editor Form. The sample view of your report updates to display selected data items.

3.1.2 Foxfire! Data Dictionary

A unique feature to Foxfire! is the Data Dictionary, accessible through the Request Manager Screen and the Request Editor Screen. The Dictionary contains definitions for each data item, including the data item name, item description and type, and display, expression and calculation information.
3.1.2.1 Accessing the Data Dictionary

To access the Data Dictionary select the “Dictionary” button on top of the Request Manager Screen. The Data Item Editor Form (Data Dictionary) appears (Figure 3-7).

Figure 3-7. Data Item Editor Form (Data Dictionary).

3.1.2.2 Viewing Data Item Definitions

To view the definition of a particular data item, select the “List” button on the Data Item Editor Screen. A scrolling list of all data items appears (Figure 3-8).
Double-click the data item you wish to view. The data item displays in the fields on the Data Item Editor Screen.

Select the "Next" button on the bottom of the Data Item Editor Screen to skip ahead to the next data item in the list, or the "Prev" button to move back to the previous data item in the list.

### 3.2 Filtering Data Items

To filter data meeting certain criteria out of your request, select the "Filter" button to display the Filter Builder. The Filter Builder lets you specify what information you want to keep and what information you don’t. For example, you may want to see only debtors who owe more than $100 on your report. To obtain this result, you create a filter. Figure 3-9 displays the Data Items Filter Form.
**Figure 3-9. Data Items Filter Form.**

Foxfire! filters the data and returns only the records that you want to see on your report. Each row on the Data Items Filter Screen represents a single condition that compromises part of the filter. Each filter is comprised of the following parts:

- The data item to which to apply the filter
- The is/is not operator
- The filter relationship
- The filter value

To create a filter, you must add conditions to the filter one at a time. Begin by clicking the **"Add"** button, located at the bottom of the Data Items Filter Form. A new window appears displaying a drop-down list of data items. Choose the data item to filter and the remaining fields on the screen enable:
The “Is (Not)” field indicates whether the relationship between the data item and the value being compared is true (IS) or false (IS NOT). Select the appropriate option. The “Relationship” field defines the relationship between the data item and the value being compared. Choose the comparison you would like to make from the drop down list.

In the “Value(s)” field, enter the attribute by which you would like to narrow your data. You may enter a constant value, such as a number, date, character string, or yes/no.

If you flag the “Ask at Runtime” field, Foxfire! displays a dialog box requesting the value when you run the request. This allows you to create reports with different results from the same request depending on the values entered at runtime.

Flag the radio button labeled “Empty,” “Zero,” or “Blank” (depending on your selection in the “Relationship” field) to filter data that is either blank (or zero if a numerical field), or not blank, depending on your selection in the “Is (Not)” field. Flag “Another Data Item...” to compare the first data item to another. Finally, flag “Build Expression...” to create more complicated expressions.

The “Show List of Values...” button located on the bottom of the screen displays a list of valid values for the data item selected when clicked. For example, if the data item is an account number, the “Show List of Values...” option displays a list of account numbers in your Debt$Net™ system. From the scroll list (Figure 3-10), you may choose a valid value to enter into the “Value” field. Double click on your selection or highlight your choice and click <Enter>.
Click the “OK” button when you finish building the filter. You return to the Data Items Filter Form. You may continue adding filters by clicking the “Add” button and following the instructions in this section.

3.2.1 Filter Command Buttons

The buttons located below the filter list window on the Data Items Filter Form are filter command buttons allowing you to further modify your filters. Table 3-3 describes the purpose of these buttons.
### TABLE 3-3 FILTER COMMAND BUTTONS.

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit</strong></td>
<td>The “Edit” button lets you edit existing filter conditions already added.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>“Add” lets you add new filter conditions or further narrow an existing filter.</td>
</tr>
<tr>
<td><strong>Or</strong></td>
<td>The “Or” button lets you broaden filter conditions by joining two conditions into an “either/or” pair.</td>
</tr>
<tr>
<td>(</td>
<td>The bracket buttons let you group filters to control the order in which filter conditions are applied. Parenthesis must be used in balanced pairs.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>The “Delete” button lets you remove the selected filter condition.</td>
</tr>
<tr>
<td><strong>Union...</strong></td>
<td>The “Union...” button lets you merge the results of two requests. After selecting the button, the Union Requests Form displays. Flag the “Run Request” field and select the request you wish to merge with.</td>
</tr>
<tr>
<td><strong>Top N...</strong></td>
<td>The “Top N...” button opens a dialog box that lets you limit your report to a specific number of results.</td>
</tr>
<tr>
<td><strong>Ask at Runtime Options...</strong></td>
<td>The “Ask at Runtime Options...” button lets you include additional filter values to be set when you run your requests.</td>
</tr>
<tr>
<td><strong>Help...</strong></td>
<td>The “Help...” button displays the Foxfire! Explainer Window, as discussed in Section 1.3.</td>
</tr>
<tr>
<td><strong>Dictionary...</strong></td>
<td>The “Dictionary...” button displays Foxfire!’s Data Dictionary. Use this to learn more about a DebtSNet™ data item. For more information see Section 3.1.2.</td>
</tr>
</tbody>
</table>

After you add all necessary filters, select **OK** to return to the Request Editor Form. The area below the **Filter...** button lists your established filter criteria.
3.3 SORTING AND GROUPING RECORDS

The “Sort + Group...” button on the Request Editor Form allows you to sort records by a particular data item and allows you to group report results. “Sort” means organizing report detail lines by a particular data item (for example, account number), in either ascending or descending order. “Group” means organizing a set of detail lines into a separate section of the report.

To begin, select the “Sort + Group...” button to access the Sort + Group Selector Screen (Figure 3-11).

3.3.1 Choosing Data Items for Sorting

On the left side of the Sort + Group Selector Form is a box labeled “Available,” containing all available data items upon which information may be sorted and/or grouped. The “Display Data Items” fields allow you to choose the data set by which to sort and/or group. Flag “In Request” to sort only the data contained in the request. Flag “All” to sort the request based on all potential data items from the “Available” list.

To sort by an item, double click it in the “Available” list. The item moves to the “Sort by” list. Request output will be sorted by the item indicated. For example, if you select to sort by account number, all report output displays in order of account number. To remove a data item from
the “Sort by” list, double-click on the item. The data item will disappear from the “Sort By” list and be returned to the “Available” list.

To change the order of items in the “Sort by” list, highlight the item you would like to move in the “Sort By” list. Drag the item up or down into the new position that you desire.

### 3.3.2 Changing Ascending or Descending Order

The arrow to the left of each data item in the “Sort By” list indicates whether the sort order is ascending or descending. An arrow pointing up indicates a data item will be sorted in ascending order (meaning from A-Z or 0-9). An arrow pointing down indicates that a data item will be sorted in descending order (meaning from Z-A or 9-0). Foxfire! defaults to ascending order, but you may change the order to descending by highlighting the data item whose order you would like to change and selecting the “Descending” button. You may switch the order back and forth from ascending to descending for each item by clicking on the “Descending”/“Ascending” buttons.

**NOTE:** If you have set specific group breaks, changing the sort criteria may completely change the nature of the request’s output. It is recommended that you make a copy of the request to “experiment” with before modifying the original.

### 3.4 CREATING GROUP BREAKS

A group break is an interruption in the printed output. Group breaks allow special processes to be performed at the end of a record group, such as the data being calculated into a subtotal. When you run your request, a group break does several things:

1. Prints a horizontal line under each numeric item.
2. Prints a subtotal.
3. Skips a line.
4. Prints a group heading to identify each new group.
5. Skips another line.

To create a new group break, highlight a data item in the “Sort By” list and click the “Group” button. Once an
item is flagged for grouping, a “Grp” indicator appears to the right of the
data item’s name. The “Group” button toggles to “Ungroup” and may be
selected to cancel the group break.

3.4.1 Choosing Group Break Options

You may select options to determine group break calculations and
formatting. To choose group break options, select the “Options...” button
on the Sort + Group Selector Screen. The Group Options Form appears
(Figure 3-12).

![Figure 3-12. Group Options Screen.](image)

The Group Options Screen is divided into three sections: Option Types,
Select Option Details List, and the Selected Data Items List. At the top
of the screen, select “Calculations” to add custom calculations to a group
break; select “Formatting” to choose different formatting styles for the
group break; or select “Show All Selections” to view all summary
calculations and formatting options for group breaks. To edit options
when selecting “Show All Selections,” you must select the Calculation
or Formatting options.
3.4.2 Adding Calculations

Foxfire! automatically totals numbers when a group break occurs, but you may also add other custom calculations to your group break. To add calculations, flag the “Calculations” option type. A scroll list of data items displays in the Select Option Details List (the left box) and the calculation buttons enable. On the Select Option Details List you may display only data items included in your request by selecting “Show Data Items: In Request,” or you may display all data items available in Debt$Net™, by choosing “Show Data Items: All”. Use the calculation buttons to add as many calculations to a group break as you wish (Table 3-4 describes calculation options).

You may attach calculations to one group break or to all group breaks. Your selected grouped data items display in the Selected Data Items List. To attach calculations to a particular group, highlight the grouped data item on the list and flag the “Add Calculations to: Highlighted Group Break.” To attach the calculation to all group breaks, flag the “Add Calculations to: All Breaks.”

To add a calculation, highlight the group break for which you would like to make the calculation from the Selected Data Items List. Choose a data item to include in the calculation from the Select Option Details List. Double-click the data item to add it to the Selected List. Next, select the button indicating the type of calculation to perform. The calculation and data item appears below the desired group break in the Selected List. Table 3-4 describes each button and the type of calculation it performs. To remove a calculation, double-click on the data item in the Selected List.

<table>
<thead>
<tr>
<th>TABLE 3-4 CALCULATION BUTTONS.</th>
</tr>
</thead>
<tbody>
<tr>
<td>BUTTON</td>
</tr>
<tr>
<td>--------</td>
</tr>
<tr>
<td>Sum</td>
</tr>
<tr>
<td>Avg</td>
</tr>
</tbody>
</table>
## 3.4.3 Formatting a Group Break

To add formatting options to a group break, flag the “Formatting” option type on the Group Options Form. A list of formatting options displays in the Select Option Details List and the Selected Data Items List (under the heading “Apply Options to:”) contains all grouped data items you added to the request. (Figure 3-13).

<table>
<thead>
<tr>
<th>BUTTON</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count</td>
<td>Counts the number of items returned within the group (the number of detail lines).</td>
</tr>
<tr>
<td>W-Avg</td>
<td>Displays the weighted average of numeric data items in the specified group.</td>
</tr>
<tr>
<td>Min</td>
<td>Displays the minimum value of numeric data items in the specified group.</td>
</tr>
<tr>
<td>Max</td>
<td>Displays the maximum value of numeric data items in the specified group.</td>
</tr>
<tr>
<td>StdDev</td>
<td>Displays the standard deviation of the numeric data items in the specified group.</td>
</tr>
<tr>
<td>Variance</td>
<td>Displays the variance of numeric data items in the specified group.</td>
</tr>
</tbody>
</table>

![Figure 3-13. Formatting Options.](image-url)
To format a group break, highlight the group break to format from the Selected Data Items List. Choose a formatting option from the Select Option Details List by double-clicking it. The formatting option appears below the group break in the Selected List. Table 3-5 explains each formatting option. Remove a formatting option by double-clicking the option in the Selected Data Item List.

**NOTE:** The New Page formatting option is the only one available for the group break “Grand Total.”

### TABLE 3-5 FORMATTING OPTIONS.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>New page</td>
<td>Inserts a page break after each group break.</td>
</tr>
<tr>
<td>Reset page #</td>
<td>Resets the page number to 1 after each group break.</td>
</tr>
<tr>
<td>No group header</td>
<td>Suppresses the group header.</td>
</tr>
<tr>
<td>No group footer</td>
<td>Suppresses the group footer.</td>
</tr>
<tr>
<td>Repeat hdr if grp continues</td>
<td>Repeats the group header if the group continues to another page.</td>
</tr>
<tr>
<td>New pg if &lt; # lines for grp</td>
<td>Displays a window prompting you to indicate the minimum number of lines required following a group header before a new page is started for the group.</td>
</tr>
</tbody>
</table>

### 3.5 OUTPUT SELECTOR FORM

Output options determine the way a request runs, from the format of the page layout to the printer you would like to use. The Output Selector Form, accessible through the Request Editor Form, lets you determine the output type, layout, style, customization, formatting, printing, and special processing options. From this screen you may override any selections made on the New Request - Type and Style Form (Section 3.1) for this request.

#### 3.5.1 Selecting the Output

To select output options, select the “Output...” button on the Request Editor Screen. The Output Selector Form appears (Figure 3-14).
First, choose a primary output type for your request. The primary output type is the main source of output for your request. To choose a primary output type, select an option from the “Output Type” drop down list:

Although you may select any displayed output type, the most commonly used are Report, Browse or Labels. Table 3-6 describes each primary output option.
TABLE 3-6 PRIMARY OUTPUT OPTIONS.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>Creates one of four report types: Columns, Form, Master/Detail - Group Headings, Master/Detail - Page Headings.</td>
</tr>
<tr>
<td>Browse</td>
<td>Creates a scrollable table of results. May not be edited.</td>
</tr>
<tr>
<td>Labels</td>
<td>Creates formatted labels for custom and Avery formats.</td>
</tr>
<tr>
<td>Graph</td>
<td>Creates a bar chart or pie graph.</td>
</tr>
<tr>
<td>Spreadsheet</td>
<td>Outputs data to a spreadsheet file.</td>
</tr>
<tr>
<td>Mail Merge</td>
<td>Creates data files suitable for text merges in most major word processing software.</td>
</tr>
<tr>
<td>ASCII</td>
<td>Outputs data to a plain text file. You may specify fixed length or delimited.</td>
</tr>
<tr>
<td>Data</td>
<td>Outputs data to a FoxPro .dbf table.</td>
</tr>
</tbody>
</table>

Once you select a primary output type, select a secondary output type from the drop down list to the right of the “Output Type” field. Different options display depending on what you chose as the primary output type. Because most users use only the report, browse and labels options, only the secondary output options for these output types will be discussed here.

REPORT: Choose a secondary output type from the following options:

Columns: One column for each data item in the request.

Form: One detail record displayed at a time, with data items vertically aligned.

Master/Detail Group Headings: Grouped items display with new group headings (one for each group), and other data items display in columns below the group break.

Master/Detail Page Headings: Grouped items display with a new heading produced only at the top of a new
page. Other data items display in columns below the group break.

**BROWSE:** There are no secondary output options available for the Browse output type.

**LABELS:** Selecting the Secondary Type field displays the Label Type Window. (Figure 3-15). Select the label to create from the scrolling list. You may sort this list by name or by height/width by flagging the corresponding fields at the bottom of this window. Choose to display 1, 2, 3, or 4 labels across the screen, and choose to view label measurements in inches or millimeters. Once you select the label type you would like to create, select the “OK” button. The label type you choose appears in the secondary type field on the Output Selector Form.

![Figure 3-15. Label Type Window.](image)

3.5.2 Choosing a Layout Style

If you select Report or Label as your primary output type, Foxfire! offers additional layout and style options to modify the output appearance. The layout style determines both the page setup and fonts used in the reports and labels. The output style you selected on the New Request - Type and Style Form (Section 3.1) displays in the “Style” field. You may keep this option or change it.
To select a layout style, select an option from the “Style” drop down list. If you select a new option, Foxfire! overrides any previously selected layout options. For more information about layout styles, see Section 3.1, Adding New Requests.

### 3.5.3 Selecting Additional Options for Reports

If you select Report as your layout type, you may specify additional output options such as showing filter conditions, specifying line and column spacing, changing formatting, or suppressing repeat values. To specify additional output options, select the **Options** button on the Output Selector Form. The Layout Options Form appears (Figure 3-16).

![Layout Options Form](image)

Figure 3-16. Layout Options Form.

In the “Show Filter Conditions on Report” box select whether to display filters in report headers. Select “None” to specify that you do not want to print filter conditions in the report header. Select “All” to print the filter conditions in the header every time the request is printed (selecting this option allows you to view how the report was filtered). Select the “Ask-at-Runtime Conditions Only” option if you would like to be asked whether to print the filter conditions every time you run a request.

The “Formatting” box allows you to select specific formatting options. Choose “Always Prompt for Header” if you would like to be asked for a report header every time you run the request. Choose “Suppress Detail
Lines” to display group and summary sections without running the detail lines (only titles, headers, group breaks, totals, etc. will print on the report). To run the request with all data fit into one page, select the “Fit to Page” option.

The “Detail Line Spacing” box allows you to indicate how many lines to allot for each detail line on the report. To increase the number of lines, enter a number in this field.

The “Suppress repeat values” box allows you to exclude repeated values from the specified number of columns. Enter the number of columns for which you wish to suppress repeat values in the field. If you do not wish to suppress repeated values, enter zero.

The “Column Spacing” box determines the number of spaces inserted between columns. The Foxfire! default is one space, but you may increase the number of spaces by entering a number in this field.

Once you make your selections, click “OK”. You return to the Output Selector Form.

### 3.5.4 Editing Layout Customization

Customizing a layout can be quite complicated and requires extensive knowledge of Visual FoxPro and Foxfire! SQL. If you are knowledgeable about Visual FoxPro and would like to modify a customized report or move fields, you may do so by selecting the “Edit...” button on the Output Selector Form. The Request Editor Form appears (or Label Editor Form, if you are creating labels), and you may adjust your layout.

When you finish modifying the layout, select the “X” in the corner of the screen to close it. A dialog box appears, asking if you would like to save the changes you have made. Click “Yes” to save. Foxfire! may prompt you to enter a new filename upon saving. The name you choose will display in the “Layout” box on the Output Selector Form.

**CAUTION:** Because of the complexity of customizing a layout, this process is not recommended for most users. If you do not have Visual FoxPro programming knowledge, do not attempt to edit the layout.
3.5.5 Choosing Another Layout

To use the layout from a previously created report layout, you may select the “Choose...” button on the Output Selector Form. Foxfire! prompts you to select the layout to use. Select “OK” to select the layout. The name of the layout displays in the “Layout” field.

3.5.6 Using the “Save As” Option

To save your report layout under a different name, select the “Save As” button on the Output Selector Form. Foxfire! prompts you to choose the directory where you would like to save the layout, and to enter a new filename. Select “Save” again. This allows you to use your layout for future requests.

3.6 SETTING UP OUTPUT DESTINATIONS

Foxfire! offers three output destination options: you may send your request to the printer, you may preview your request on the screen, or you may store your request in a file to save to a disk.

To send the output to a printer, select “Printer” under the “Send To” list. Select the “Setup...” button to set up a new printer configuration, or select “Options...” to change current printer settings. If you choose this option, the output will print to the selected printer every time you run that request.

To preview the output on the screen, select “Screen” from the bulleted list. The request output displays on the screen, and options are provided allowing you to print the report or save it to a file.

To store the request results to a disk automatically every time you run the request, choose “File...” from the list. The filename defaults to the same name as the request. You may leave the default name or enter a new name when prompted. Click the “Save” button to save the new file.

3.6.1 Adding Special Processing Options

Special processing options allow you to run a user-defined external process as part of the request. Before you attempt to add any special
processes to your requests, it is recommended that you contact the Debt$Net™ Technical Support Staff.

3.7 PREVIEWING REQUESTS

The Preview Window allows you to view a request before printing to paper or to a file. To access the Preview Window, click the “Preview” button on the bottom of the Request Editor Form or on the Request Manager Screen. Foxfire! begins generating the request and a box appears displaying progress.

If the request output is too large to fit on the screen, a window displays providing several previewing options (Figure 3-17). You may select “Fit to Page” to view the entire request on the screen, or “Run As Is” to display the request in its normal size, running off the screen. You may also choose “Master Detail Layout,” which relieves layout data overcrowding. A window appears with instructions on how to set up the master detail layout. The button “Other Suggestions” will provide you with more previewing options and suggestions when selected.

Figure 3-18. Previewing Options Window.

When the preview displays, a small toolbar appears at the top of the screen (Figure 3-19). This toolbar allows you to go to the first page, a previous page, or a specific page. You may also skip ahead to the next page, the last page, or exit the window. The zoom feature lets you enlarge or shrink the preview, and the printer icon lets you print the request to a printer or file.
Figure 3-19. Request Preview.

Once you review the Request Output Preview, you may close it by selecting the door icon on the Print Preview Toolbar. The Output Choices Window displays, providing additional options (Figure 3-20). Table 3-7 describes the additional options.

Figure 3-20. Output Choices Window.
### TABLE 3-7 ADDITIONAL OUTPUT OPTIONS.

<table>
<thead>
<tr>
<th>OPTION</th>
<th>EXPLANATION</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print</strong></td>
<td>Print the request directly to paper. Select your printing options when the Print Window appears.</td>
</tr>
<tr>
<td><strong>Edit Layout</strong></td>
<td>Make modifications to your request layout. Unless you have Visual FoxPro programming knowledge, this option is not recommended.</td>
</tr>
<tr>
<td><strong>Preview</strong></td>
<td>View the Request Preview.</td>
</tr>
<tr>
<td><strong>Show SQL</strong></td>
<td>View Foxfire!’s SQL programming commands.</td>
</tr>
<tr>
<td><strong>Close</strong></td>
<td>Exit the Request Preview and return to the Request Manager Screen.</td>
</tr>
</tbody>
</table>